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CircuitMaker is a design solution that is both easy to use and delivers a powerful set of design tools
for developing electronic products, from concept to manufacture. Tailored to suit electronics makers,
hobbyists, and members of academia, CircuitMaker oﬀers a reﬁned design environment and a
comprehensive set of features for managing design content.
You can explore CircuitMaker’s features and interface by simply experimenting with the software, by
diving in to create a new design project, or better still, by ﬁrst scanning through this documentation to
give you a head start.
Aside from a valuable introduction to the CircuitMaker environment - the main focus of this page - the
following additional articles are available in this section of the documentation, collectively providing a
foundation with which to get you up and running with the software:
Driving a PCB Design through CircuitMaker – A step by step tutorial style guide to creating a PCB
design in CircuitMaker
Project Management – An overview of managing design projects in CircuitMaker
Component Management – An overview of managing design components in CircuitMaker
Variants in CircuitMaker – A detailed article on how to deﬁne and manage design Variants in
CircuitMaker
Schematic Editing Strategies – Learn the basics about working in the CircuitMaker Schematic editor

The CircuitMaker Environment
CircuitMaker incorporates a full set of PCB design tools in a uniﬁed design environment that features a
modern, easy to use design interface. User interface features that support a smooth and intuitive
workﬂow, from schematic and PCB design through to the design release stage, include:
A reﬁned ribbon-style menu system
Flexible, multi-tab design editor windows
Dockable panels for working with design documents
A full set of command shortcut keys
Context-sensitive web-based Help reference
User conﬁguration preferences
As you move between tasks in the CircuitMaker design workﬂow, the system responds to the current
requirements by opening the design editors, panels and ribbon menu set that you need for the task at
hand. While maintaining a consistent look and feel, the design environment dynamically changes to
present the appropriate tools and windows while you design.
The user interface elements are nevertheless consistent in style, positioning and function, and can be
summarised as indicated below.

For information about what is currently under the cursor, press F1.

Multiple documents can be opened for editing, each presenting with a separate Document Tab
at the top of the workspace.
As you switch from one document kind to another, for example from a schematic sheet to a PCB
design, the ribbon menu and tool options automatically change.
The commands available from the ribbon’s File tab remain the same, regardless of the
document kind. This menu provides access to ﬁle management operations and the system

environment conﬁguration preferences.
Workspace panels can be docked along any edge of the workspace, or ﬂoat on top of or beside
the application.

Ribbon Command System
CircuitMaker’s ribbon-style menu provides a dynamic and highly-visual control system that allows you
to ﬁnd the commands you need quickly.
Commands and menus buttons are arranged in groups under a series of tabs that all change to suit
the current task. The result is an eﬃcient and easy to use command interface that makes the most
use of the available screen space.

The ribbon style menu system oﬀers the appropriate collection of command buttons for the task at hand.

Using the ribbon menu is as simple as selecting a suitable tab, or quickly ﬂicking through them, to
ﬁnd a set of commands that suit your current need.
So when editing a schematic for example, the Cross Probe tool command is logically found within
the Find and Replace group under the Tools tab. Where additional command options are available
(such as Annotate Schematics Quietly, above) the button oﬀers a drop-down menu.

In the CircuitMaker documentation the nomenclature for ribbon command buttons is Tab |
Group | Button » Sub Menu Command, where the ﬁnal command refers to a button’s
drop-down menu selection (where available). So the two examples mentioned above would
be referred to as:
Schematic Cross Probe – Tools | Find and Replace | Cross Probe, or Tools | Find and
Replace |
Annotate Schematics Quietly – Tools | Annotation | Annotate » Annotate Schematics
Quietly, or Tools | Annotation |

» Annotate Schematics Quietly

Note also that the ribbon’s leftmost
button (not a Tab as such) accesses a ﬁxed menu for
managing projects, document ﬁles and external systems (ﬁle import and online help). In the
documentation these commands are referred in the standard drop-down menu manner, for example
File » Open Project or File »

.

The ribbon menu features dynamically scalable buttons that will adjust to make the most of

the available menu space, such as when using CircuitMaker on a small PC screen or at a
reduced window size.

For easy access to common ﬁle and editing commands the ribbon menu features a Quick Access Bar
area located above the ribbon tabs.

The Quick Access Bar provides
direct commands buttons for basic
ﬁle and editing tasks.

This oﬀers buttons to directly save a document, and undo/redo buttons for the last edit change –
hover the mouse cursor over each button to see its function hint text. The leftmost CircuitMaker icon
button
provides standard window controls such as Maximize/Minimize, Close etc.

Start page
The CircuitMaker Start page, opened when you ﬁrst install the software, provides a central location
from which to access many common system tasks and system conﬁguration options. The page is
designed to oﬀer a simple and direct way to access routinely used areas of the software, such as the
My Account page and design-based tasks (opening or creating a new project), as well as software
conﬁguration options through Extension & Updates, and the CircuitMaker Community Forum.
Access the Start page from the ribbon’s View menu: View | System | Start.

Task links on the Start page provide single-click access to key actions and conﬁguration features. The image
above shows the result of clicking the Project Documents entry.

Select Start to access the overview page for the CircuitMaker Community. This page provides
quick access to projects that you've created, and versions of components that you have built. It
also provides a search facility for looking up components across the entire Ciiva database.
Access is provided to the wealth of projects created by the community, with most popular, new
and watched projects listed here. Access to the Forum is also provided, with the latest forum
threads listed here. Latest activity within the community is also presented. This includes recent
activity related to projects, components, and the forum.
The full activity list can be viewed on the Stream page. This presents all activity, with
ﬁltering to view only unread notiﬁcations, or activity aﬀecting the forum, projects, or
components only. Access to the Stream page is made by clicking the Show More
link, at the bottom of the Latest Activity section on the Start page. Alternatively,
access can be made by clicking the Inbox control - at the top-right of the Start, My
Account, or Forum pages.
Select My Account to manage your CircuitMaker Community proﬁle, and to access the facility
for changing your account password.

Select Forum to access the CircuitMaker Community Forum.
Select New Project to create a new blank project.
Select Open Project to load an existing PCB design project from the Community Vault. You will
be presented with the Projects area of the community, from where to browse for the speciﬁc
project you wish to open and work on.
Select a previously opened project from the Recent Projects shortcut list to open it in
CircuitMaker.
Select Project Documents to see a graphical preview of the documents in the currently active
project. Double click a preview to open the document in CircuitMaker.
Select Extensions & Updates to access pages from which to extend software functionality,
where available, and to also update your installation to the next released version - directly from
within the CircuitMaker environment.
Select Preferences to access the Preferences dialog, in which to conﬁgure system-level
options for various editors within the software.

Document Windows
When you open a document, it becomes the active document in the associated editor in
CircuitMaker's main design window. For example, a schematic document is opened and edited in a
Schematic Editor window, a PCB document in the PCB Editor window, and so on.
Multiple documents can be opened simultaneously, where each has its own selection tab at the top of
the design window. Documents can occupy the entire workspace, or the workspace can be shared
between multiple open documents via the Split commands - available from the menu associated to a
document's tab. Documents can then be dragged from one split region to another.

Design document windows can be stacked or conﬁgured in vertical or horizontal splits.

Panels

More information: See the Panel references in this documentation, such as the Schematic Panels and
the PCB Panels entries.
Documents store objects and entities, and are edited in the main workspace. Panels are used to give
an alternate view of data in the current document, for example the PCB panel can be used to browse
by Components or Nets.
Panels are also used to work across the environment, for example the Projects panel is used to open
any document in the project, as well as display the project hierarchy. Document-speciﬁc panels can
only be displayed when that document-type is the active document.
All panels are accessible from the menu’s View tab.

The main project panels are accessed from the System group under the View tab, while more document speciﬁc panels
are available in their dedicated groups.

Panels can ﬂoat in the workspace, they can be docked along the edge of the CircuitMaker
environment, or they can be set to pop-out from an edge.
Switch between multiple grouped panels using the tabs at the bottom of the panel area.

Switching between grouped panels.

Click and drag on the panel name to move just that panel, click and drag elsewhere on the
panel caption bar to move a set of stacked panels.
Right-click on the panel name to conﬁgure its docking behavior.
Switch a panel from docked to pop-out via the pin button at the top of the panel.

Control whether the panel is pinned or popped-out.

Finding Help
CircuitMaker provides multiple levels of help information, both locally in the software and through
online documentation.
At the immediate level, the system provides basic information via pop-up text as you hover
over a control button, and most action dialogs include hints to help you conﬁgure its settings
and options.
The main in-depth help information can be accessed by simply pressing F1 over an object,
panel, menu entry, or button. This provides a direct link to the relevant part of CircuitMaker’s
online documentation.
The menu Help button (View | Help | Help) will open the main page of the online
documentation.

Shortcuts
When you are comfortable with working with the CircuitMaker interface and design ﬂow, a good way
to streamline and speed up the process is through the use of keyboard shortcuts.
The system oﬀers pop-up hints for shortcuts, and a context-sensitive list of shortcuts.
To see shortcuts for the ribbon menu tabs, press the Alt key.
Open the Shortcuts panel (View | Help | Shortcuts) to see a list of common keyboard
shortcuts for the system and the active editor. For example, with the panel open, changing from
the schematic to the PCB editor will re-populate the list with PCB shortcuts in place of
Schematic shortcuts.

System Preferences
CircuitMaker provides a centralized location for the setting of environment options across all
document editors and systems – the Preferences dialog.
Access the Preferences dialog by selecting File |
menu).

(located at the bottom of the File

The Preferences dialog is the central point for conﬁguring CircuitMaker's system-wide user preference options.

This features a tree-like navigation structure that helps you quickly ﬁnd and set system-wide
preferences. The current preference settings will be retained by CircuitMaker, but can also be saved
or loaded to/from a single compressed format ﬁle (DXPPreferences*.DXPPrf) with the
and

buttons.

Getting to know CircuitMaker
A good way to become familiar with CircuitMaker’s interface, editors and command structure is to
simply load a design from the community projects, and explore the system’s functionality with a real
PCB project. To do so, from the Start page (View | System | Start) click Open Project and then
browse to a project of interest.
However the best way to understand the workﬂow and deeper features of CircuitMaker is by working
through the documentation’s From Idea to Manufacture design tutorial guide. This provides a step-bystep explanation of how to create a complete design in CircuitMaker, and covers all aspects of the
process – literally from idea to manufacture.

See From Idea to Manufacture - Driving a PCB Design through CircuitMaker
Use the guide as a complete walk-through process for creating your own design (or the one
presented), or access key parts of the guide as a reference when needed.
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